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Introduction 

Description 
The Focus360° product is a web-based population health management tool that provides 
reports and analyses designed to enhance the ability of health care and community-based 
organizations to care for the people they serve. The product combines clinical activity 
reports with predictive analytics and quality measure status reports. Focus360 provides 
reporting and charts that combine data from entire patient rosters or subgroups.  

Focus360 can be used to understand the clinical activity that patients receive outside 
one’s own organization, identify patients at highest risk of various adverse events, and 
determine which patients have gaps in care that need to be addressed. The data in 
Focus360 is generally updated within 24 to 48 hours of clinical activity, unlike population 
health management tools that depend on claims or other data that can take weeks or 
months to update. 

Audience 
This user manual is intended for Behavioral Health Organizations (BHOs), Community 
Based Organizations (CBOs), Federally Qualified Health Centers (FQHCs), Independent 
Physician Associations (IPAs), and Accountable Care Organizations (ACOs) that are 
customers of the Focus360 population health management tool from Healthix. Focus360 
allows users to access and evaluate a wide range of clinical data and analytics for their 
patients/clients.  

During the initial setup of Focus360, customer organizations will work with their Healthix 
Relationship Manager and/or a Healthix Project Manager to enroll in the product, complete 
training, and acquire user account credentials. Healthix recommends that customer 
organizations include staff from their IT and Business Operations teams in the Focus360 
setup process. Once the product has been set up and is operational, there is no limit on 
the number of users. The end users can be anyone who needs to check quality measure 
performance (this can include, but is not limited to data quality teams, IT teams, and 
physicians). 

 



Log In Access 

Supported Browsers  
Focus360 is accessible via the Healthix Portal. For best performance, the recommended 
browsers for Focus360 are Windows Edge, Chrome and Firefox with the most recent 
versions 

Log In Process 
To access Focus360, please follow the steps:  

1. Navigate to the Healthix Portal (Portal.Healthix.org)  

 

2. Enter your username and password. (Note: if you are a new Healthix portal user, you 
will receive an email with your login credentials upon completing any mandatory 
training videos – screenshot of email below). 

 

https://portal.healthix.org/csp/healthshare/hsviewer/Healthix.Common.HS.UI.HomePage3.cls


3. Complete multi-factor authentication by entering the security code sent to you via 
SMS text. (Note: If it is a first-time login attempt, you will be prompted to enter a 
phone number if there is not one already on file for your account.) 

 
4. You are now in the portal. Select the Focus360 Tab to navigate to the Focus360 tool.  

 



 

 

General Functionality 

Search 
 

 

  

 

Search can be found in the top right hand corner of your home landing page or any further 
navigation.  

Parameters include:  

• Search by ID: Patient MRN  
• This is the MRN or Patient ID designated by the customer organization  



• Information: First Name and/or Last Name and/or Gender and/or Date of Birth.  
• Press “SEARCH” button to search, pressing “Enter” in keyboard will not 

generate a response.  
• The search requires one character minimum and will not autocomplete 

recommendations for the search.  

Patient List 
In the patient lists, you will see bold-text information and non-bolded information. The 
bolded information is selectable, as this indicates that the patient has granted consent. If 
selected, it will navigate to the Patient Profile page. If the text is non-bolded, this 
designates that there is no consent on file for the patient or the patient has denied consent 
and is not selectable. 
 

  

Sorting rows 
Throughout the modules, you are able to click on the header of any patient list to sort it. 
Clicking in a column with letter characters will sort it alphabetically Z -> A, then clicking 
again will sort it alphabetically A -> Z. Clicking on any column with date value will sort it by 
MM/DD/YYYY.  

Filtering 
Filters vary by report, but most include Date Range and Demographics.  

• Date Range – choose a standard timeframe – 7 days, 30 days, 90 days, 120 days, or 
enter specific start and end dates.  



 
• Demographics Options: [please refer to Data dictionary for mapping definitions] 

o Age range: Multiselect 10 Age Brackets 
o Race: Multiselect 8 Categories 
o Ethnicity: Multiselect 4 Categories 
o Gender: Multiselect Gender (see Data dictionary for more notes under 

Detailed Data Elements tab)  

 

 

Note: You must click APPLY after selecting filter options to regenerate the patient list 
below.  

 



 

Additional filters are provided in certain reports. 

Download/Export 

 

Any display can be downloaded to the local computer as an XLSX file that can be opened in 
Excel. Please note that a large number of rows can take a few minutes to generate the 
download.  
 
 

Data Library 

Where does the data come from? 
The data in Focus360 comes from Healthix’s database of participant’s data. The data is 
pulled from the more than 9,000 healthcare organizations that are connected to Healthix.  

What data can be found on Focus360? 

• Encounter Data 
• Comprehensive Clinical Data (Consent must be granted in order to access this 

data) 

Which Patients Can be Found in Focus360? 
Patients included in Focus360 are based on an organization’s connection with Healthix. 
Connections can be via provider roster flat files, EHR connection, subscription file, etc. For 
any specific questions regarding your organization’s connection source with Healthix, 
please contact your assigned Relationship Manager. If you don’t know your Business 
Relationship Manager, you can look them up here: https://cx.healthix.org/find-your-
relationship-manager. 

Compliance  

Consent Rules 
In New York State, patient consent is required for health care organizations to view a 
patient’s detailed health records through Healthix. The level of data accessible to view in 

https://cx.healthix.org/find-your-relationship-manager
https://cx.healthix.org/find-your-relationship-manager


Focus360 is dependent on patient consent status. Consent rules for this product are as 
follows:  

- 360 View – If there is a grant or no consent on file, then the data is visible. If there is 
a deny consent on file, then the data is not visible.  

- Unplanned Readmissions and Early Returns - If there is a grant or no consent on 
file, then the data is visible. If there is a deny consent on file, then the data is not 
visible. 

- HbA1c Results - If there is a grant on file, then the data is visible. If there is a deny 
or no consent on file, then the data is not visible. 

- PCP Attribution - If there is a grant or no consent on file, then the data is visible. If 
there is a deny consent on file, then the data is not visible. 

- Population Risk Management – this is a predictive model which shows de-
identified aggregate patient data as well as patient level data. Consent is not 
considered for aggregate data reporting.  In the patient level list, if there is a grant, 
then the data is visible. If there is a deny or no consent on file, then the data is not 
visible.  

- Transition Risk Management – this is a predictive model which shows de-identified 
aggregate patient data as well as patient level data. Consent is not considered for 
aggregate data reporting.  In the patient level list, if there is a grant, then the data is 
visible. If there is a deny or no consent on file, then the data is not visible. 

- Quality Measures - If there is a grant or no consent on file, then the data is visible. If 
there is a deny consent on file, then the data is not visible. 
 

Modules 
Focus360 is a system built on a web-based dashboard where reports can be selected, 
filtered, sorted, and downloaded for further analysis. From any report, you can click on a 
patient and access their full clinical history if they have provided consent.  The clinical 
history includes diagnoses, encounters, procedures, labs, and medications.  

The following lists are the available reports within the dashboard:  

360 View  
Description  
This list includes encounters for your patient population that occurred outside of your 
facility. The 360 View searches Healthix’s 9,000 participating organizations’ encounters 
and indicates if there has been an inpatient, outpatient, or emergency encounter for your 
patients at any of our participating organizations.   



 
The high-level use case is to allow your organization to have a sense of what kind of care 
your patients are receiving outside of your organization. The 360 view can inform the user 
of patient encounters that they may have otherwise not been aware of, so they can support 
the patient with follow-up care. 
 
The default view is all encounters for all patients in the past 365 days, but you can pre-filter 
on certain cohorts. If you click on the drop-down menu in the 360 View button, you will be 
shown the following list:  

 
 
   

Filters 
The Following filters are included in the 360 View Module 

o Date Range: See general functionality > Filters> Date Range section. 
o Demographic: See general functionality > Filters> Demographics section. 
• Attribution (Note: In order for this filter to populate, the Focus360 customer 

must provide us with a payer attribution file) 
• Provider Attribution (only applicable for IPA/ACO customers): options 

based on attribution file 
• Health Plan Name: options based on attribution file 
• Line of Business: options based on attribution file 

 



Columns  
The report includes the following columns. Please refer to Focus360 Data dictionary on the 
definition of these Elements. 

- Patient ID 
- Member Organization 
- Patient First Name 
- Patient Last Name 
- Patient DOB 
- Encounter Admit Date 
- Encounter Type 
- Encounter Facility 
- Facility Type 
- Diagnosis Code 
- Diagnosis Description 
- Problem Code 
- Problem Description 
- Encounter MRN 
- Encounter Discharge Date 
- Sex 
- Age 
- Race 
- Ethnicity 
- Perferred Language 
- Phone 

Pre-Filtered 360 View Reports 

High Utilizer 

 

Selecting “High Utilizer” from the filter/drop-down will populate a subset patient list that 
includes any Healthix patients with more than three ED/IP encounters in last 90 days. 



Users can click the provided filters to edit the number of encounters and days to 
regenerate a customized report. 

High Utilizer module refreshes its data typically every 24-48 hours. 

Please reference to the Data dictionary for definition of Inpatient [IP] and Emergency 
Department [ED].  

Please refer to Filters and Columns under 360 View  to review what data is available in this 
module.  

 

 

 

Referral Reconciliation 
This report lists encounters following the referral in an attempt to determine if the patient 
went to a provider to whom they were referred. Based on a custom roster provided by the 
the Focus360 customer, this module will include a list of patients who were referred to a 
specialist for care/follow-up. A timeline of interest is identified by the Focus360 customer. 

Access to this module is dependent on configuration/activation per the Focus360 
customer.  Focus360 customers will need to send a secondary roster identifying referrals 
in order to access this module.  
 
If the Focus360 customer is able to do so, a patient roster of patients that have had a 
referral to a specialist for care/follow-up within the timeframe of interest will be generated 
and shared to Healthix. Healthix will process and match up all encounters found for the 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filters
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Columns


patient. Please note at this time, Healthix is not able to reduce the encounter report to 
match the exact intention/category/specialty of the provider referrals.  

Please refer to Filters and Columns under 360 View  to review what data is available in this 
module.  

STI Encounters 
Healthix will include patient encounters within the last 60 days with a diagnosis (ICD-10), 
treatment (CPT) or both related to an STI. Please refer to the Data Dictionary for detailed 
listing of codes. 

Please refer to Filters and Columns under 360 View  to review what data is available in this 
module.  

Childhood Disability Screening 
Healthix will include any inpatient encounters during last 90 days with ICD-10, CPT, 
HCPCS or SNOMED codes related to Childhood Disability Screening. Please refer to the 
Data Dictionary for detailed listing of codes.  

Please refer to Filters and Columns under 360 View  to review what data is available in this 
module.  

Unplanned Readmissions and Early Returns 
Description 
There is a broad effort within health care to avoid repeated hospitalizations, particularly in 
situations where a patient was discharged without the proper care or planning that would 
allow them to remain at home. The Unplanned Readmissions and Early Returns module is 
designed to identify cases in which patients have returned to the hospital for a related 
cause within 30 days of a discharge.  The module follows logic from CMS (source below) in 
determining which hospitalizations might be considered an unplanned readmission or 
early return. 

■ Simoes, J., Grady J., DeBuhr, J., et al. 2017 All-Cause Hospital-Wide 
Measure Updates and Specification Report: Hospital-Level 30-Day Risk-
Standardized Readmission Measure–Version 6.0. Prepared for the Centers 
for Medicare and Medicaid Services. New Haven, CT: Yale New Haven Health 
Services Corporation/Center for Outcomes Research & Evaluation, 2017.  

 

When a user opens the module, they will find a spreadsheet-style report listing hospital 
encounters that meet the CMS criteria for an unplanned readmission (in the case of 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filters
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Columns
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filters
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Columns


inpatient stays) or early returns (in the case of emergency department visits).  Each 
encounter listed in the report occured withing 30 days from a prior hospitalization.  As you 
read across the row for a given patient, fields like Encounter Admit Data and Encounter 
Facility refer to the second, or return, hopsitalization.   

The report can be used to identify patients who may have received substandard discharge 
planning, or patients who are facing clinical, behavioral, or socioeconomic challenges that 
complicate their recovery. For support identifying patients who are at risk of a potential 
readmission, i.e. to support with proactive intervention, refer to the Transition Risk 
Management module. 

Filters 
You must click APPLY after selecting filter options to regenerate the patient list below. 

o Date Range: See general functionality > Filters> Date Range section. 
o Demographic: See general functionality > Filters> Demographics section. 
o Encounter: Inpatient or Emergency 

 

• Attribution (Note: In order for this filter to populate, the Focus360 customer 
must provide us with a payer attribution file) 

• Provider Attribution (only applicable for IPA/ACO customers): options 
based on attribution file 

• Health Plan Name: options based on attribution file 
• Line of Business: options based on attribution file 

Columns  
The report includes the following columns. Please refer to Focus360 Data dictionary on the 
definition of these Elements. 

- Patient ID 
- Member Organization 
- Patient Last Name 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering


- Patient First Name 
- Patient DOB 
- Encounter Admit Date 
- Encounter Discharge Date 
- Encounter Length of Stay 
- Gender 
- Age 
- Encounter Facility  
- Encounter Type 

HbA1C Results 
Description 
The HbA1c Results module provides access to HbA1c lab test results from a wide range of 
clinical labs connected to Healthix, including hospital labs.  Opening the module brings 
the user to a report that shows HbA1c lab test results for all patients, with each row 
representing one lab test.  A given patient may have multiple rows if they have had multiple 
HbA1c tests.  The report also includes a column titled titled “HbA1c Flag” that categorizes 
the severity of the HbA1c test findings, correlating to the following values: 

Controlled Diabetes HbA1C result of < 7% + Dx of 
Diabetes 

Elevated HbA1C result of 7-7.9% 
Pre-Diabetic HbA1C result of 5.7-6.4% 
Probable Diabetic HbA1C result of 6.5-6.9% 
Uncontrolled HbA1C result of 8 or greater 

 

Even if an organization does not specifically focus on diabetes management or prevention, 
HbA1c levels and diabetes status can be important contextual information for other 
reasons, such as the interaction of diabetes medicines with other treatments, or the 
additional daily care needed for advanced diabetes.  

Filters 
You must click APPLY after selecting filter options to regenerate the patient list below.  



 

o Demographic: See general functionality > Filters> Demographics section. 
• Attribution (Note: In order for this filter to populate, the Focus360 customer 

must provide us with a payer attribution file) 
o Provider Attribution (only applicable for IPA/ACO customers): options 

based on attribution file 
o Health Plan Name: options based on attribution file 
o Line of Business: options based on attribution file 

 

Columns  
The report includes the following columns. Please refer to Focus360 Data dictionary on the 
definition of these Elements. 

- Patient ID 
- Member Organization 
- Patient Last Name 
- Patient First Name 
- Gender 
- Age 
- Result Date 
- HBA1C Flag 
- HBA1C Result 
- Test Location 
- Facility Type 
- Diabetes DX 
- Diabetes DX Description 
- Patient Date of Birth 
- Race 
- Ethnicity 
- Patient Preferred Language 
- Patient Phone 

 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering


PCP Attribution 
Description 
The PCP Attribution Module is intended to be used by primary care organizations, or IPAs 
and ACOs that include primary care organizations within the membership. The module 
requires Focus360 customers to submit an additional file that indicates which patients are 
attributed to which primary care organizations by a given health plan. 

For primary care organizations that submit this kind of file to Healthix, the PCP Attribution 
module can be used to evaluate the PCP attribution process of the health plans they work 
with.  Health Plans often provide primary care organizations with a list of patients the 
health plan has attributed to them.  However, in practice, the attribution may not 
accurately reflect where the patient receives care.  For example, a health plan may 
attribute a patient to organization A, but the patient actually receives their care from 
organization B.  Since health plans may develop quality goals and incentives for primary 
care organizations to meet for their members, inaccurate patient attributions may 
negatively affect a primary care organization on these metrics.   

The PCP Attribution module shows a report detailing patient encounters, but in this case, 
the only patients included in the report are those who have been attributed to the primary 
care organization using Focus360.  There is column in the report that indicates which 
health plan has attributed the patient, and another column that indicates the facility the 
patient visited for each encounter.  Using this information, Focus360 users can review the 
report to see if their attributed patients are receiving care at their own organization (as one 
would expect) or if they are receiving the majority of their care elsewhere.  This information 
can provide helpful context when negotiating with health plans regarding attributed 
patients and quality incentives.   

Filters 
You must click APPLY after selecting filter options to regenerate the patient list below.  

 

• Date Range: See general functionality > Filters> Date Range section. 
• Demographic: See general functionality > Filters> Demographics section. 
• Encounter: Select either lab encounters or non-lab encounters 

 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering


Columns  
The report includes the following columns. Please refer to Focus360 Data dictionary on the 
definition of these Elements. 

- Patient ID 
- Member Organization 
- Patient Last Name 
- Patient First Name 
- Patient Atribution by 
- Patient Attribution To 
- Encounter Admission Date 
- Encounter Facility 
- Facility Type 
- Patient Consent Status 

Population Risk Management  
Description 
The Population Risk Management Module segments out a patient population to identify 
who is most at risk for an adverse event and/or disease. The module can be used for an 
organization to identify which patients they may want to allocate more resources towards. 

Healthix partners with HBI Solutions, a company founded in 2011 by Stanford University 
faculty including a physician, a PhD data scientist, and a healthcare IT business executive 
who shared a vision of improving health and reducing costs.  HBI’s specialty is using 
natural language processing, maching learning and large language models to develop 
predictive analytics in support of this module and the Transition Risk Management module. 
The data from Healthix’s participating organizations is run through the proprietary risk 
models developed by HBI to identify patients who are at higher risk for different disease 
categories/events. 

 

HBI Solutions Risk Model Overview 
In HBI Solutions Risk Modeling, Risk features are the elements that influence the risk of the 
cost, event, or condition. Below are the 11 categories of risk features used to identify a 
patient’s risk for the event/diseases identified in each model: 

 



 

 
Source: HBI Spotlight Analytics V2.1 Population Risk Mgmt and Perf Reporting Guide 

Filters 
The following section lists out applicable filters for the Population Risk Management 
module with images. Note, you must click APPLY after selecting filter options to 
regenerate the patient list below.  

Filter: Demographic 
o Demographic: See general functionality > Filters> Demographics section. 

Filter: Dx and Disease 

• Acute Disease 
• SDOH 
• Chronic Disease 

Refer to Data Dictionary > Filters Tab for detailed descriptions 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering


 

 

Filter: Population Risk  
Filter on Low, Moderate, High, or Very High Risk for the following categories: 

- Cost 
- Utilization 
- Event 
- Condition 

 



Filter: 30 and 90 Day Risk Class Change 
Filter on the following change descriptions in risk class over the last 30 or 90 days: 

• Decrease to Low 
• Decrease to Moderate 
• Decrease to High 
• Increase to Moderate 
• Increase to High 
• Increase to Very High  

Risk Models 

 

1. Cost1Y 
a. Future predicted total cost for the next 12 months, expressed as Low, 

Moderate, High, or Very High Risk 
b. Refer to the Healthix Feature Map.XLSX document, Cost tab for a full list of 

features and odds ratio associates with the Cost Risk Model. 
2. IP1Y 

a. Risk of future inpatient (IP) admission in the next 12 months, expressed as a 
Low, Moderate, High, or Very High risk of an IP admission. 

b. Refer to the Healthix Feature Map.XLSX document, Inpatient 1 Year tab for a 
full list of features and odds ratio associates with the IP1Y Risk Model. 

3. ED1Y 
a. Risk of future emergency department (ED) visit in the next 12 months, 

expressed as a Low, Moderate, High, or Very High risk of an ED visit. 
b. Refer to the Healthix Feature Map.XLSX document, Emegency 1 Year tab for 

a full list of features and odds ratio associates with the ED1Y Risk Model. 
4. Mortality 

a. Risk of Death in the next 12 months, expressed as a Low, Moderate, High, or 
Very High risk of the event. 

b. Refer to the Healthix Feature Map.XLSX document, Mortality tab for a full list 
of features and odds ratio associates with the Mortality Risk Model. 

5. Asthma 
a. Risk of an Asthma Exacerbation event in the next 12 months, expressed as a 

Low, Moderate, High, or Very High risk of the event. 
b. Refer to the Healthix Feature Map.XLSX document, Asthma tab for a full list 

of features and odds ratio associates with the Asthma Risk Model. 



6. SA  
a. Suicide Attempt: Risk of a Suicide Attempt in the next 12 months, expressed 

as a Low, Moderate, High, or Very High. 
b. Refer to the Healthix Feature Map.XLSX document, Suicide tab for a full list 

of features and odds ratio associates with the Suicide Attempt Risk Model. 
7. COPD 

a. Risk of a diagnosis of a Chronic Obstructive Pulmonary Disease in the next 
12 months, expressed as a Low, Moderate, High, or Very High risk of the 
condition. 

b. Refer to the Healthix Feature Map.XLSX document, COPD tab for a full list of 
features and odds ratio associates with the COPD Risk Model. 

8. Diabetes 
a. Risk of a diagnosis of Type 2 Diabetes in the next 12 months, expressed as a 

Low, Moderate, High, or Very High risk of the condition. 
b. Refer to the Healthix Feature Map.XLSX document, T2D tab for a full list of 

features and odds ratio associates with the Diabetes Risk Model. 
9. Opiod 

a. Risk of a diagnosis of Opioid Abuse in the next 12 months, expressed as a 
Low, Moderate, High, or Very High risk of the condition. 

b. Refer to the Healthix Feature Map.XLSX document, Opioid tab for a full list of 
features and odds ratio associates with the Opioid Risk Model. 

10. Overdose 
a. Risk of an Opioid or Narcotic Overdose event in the next 12 months, 

expressed as a Low, Moderate, High, or Very High risk of the event. 
b. Refer to the Healthix Feature Map.XLSX document, Overdose tab for a full list 

of features and odds ratio associates with the Overdose Risk Model. 

Modules Under Models 
Based on the risk model selected, the three charts below will update to reflect the model.  

 



• Risk Statistics 
o Visual Display of estimated cost, utilization and incidence for the selected 

event or condition in the last 12 months. 
• Risk Class Distribution 

o Visual breakdown of your population into Low, Moderate, High or Very High 
risk for the selected risk model 

• 30 & 90 Day Risk Class Changes 
o Visual breakdown of how many individuals within the population have had a 

change in risk class in the last 30 or 90 days 

Note: The charts can be translated into a table view by selecting the table icon in the 
bottom right hand corner of any chart. 

  

 

 

Descriptive Statistics  
Below are tiles that display additional demographic and clinical characteristics about the 
individuals within their population. When filters are applied, these graphs will update to 
reflect the charactersitcs of the selected cohort.  

 



 

• Age Group & Gender Distribution 
• Race Distribution 
• Ethnicity Distribution 
• Chronic Disease Count 

o Groups individuals in the population into one of three categories: those with 
no chronic diseases in their profile, those with one chronic disease and 
those with more than one 

• Top Chronic Diseases 
o The view defaults to the top 10 chronic diseases in the population, but can 

be changed to show the top 20, top 50, or all with the drop-down menu 

Patient List 
The patient list displays identifiers such as name, ID, date of birth, gender, age and 
assigned risk class for each risk model.  When filters are applied, the patient list will 
update to reflect the charactersitcs of the selected cohort. The list can be exported to 
Excel by selecting ‘Export’ in the top right corner.  



 

 

Transition Risk Management  
Description 
This module is designed to provide insights on your patients at risk of Inpatient or 
Emergency Department readmissions and revisits. The module includes active encounters 
and encounters discharged in the last 60 days for your organization’s patients. The module 
runs these encounters through a risk model to identify patients risk level for a readmission 
or revisit during the critical 30 day period immediately after an inpatient discharge or 
emergency department visit.  

Healthix partners with HBI Solutions, a company founded in 2011 by Stanford University 
faculty including a physician, a PhD data scientist, and a healthcare IT business executive 
who shared a vision of improving health and reducing costs.  HBI’s specialty is using 
natural language processing, maching learning and large language models to develop 
predictive analytics in support of this module and the Population Risk Management 
module. The data from Healthix’s participating organizations is run through the proprietary 
risk models developed by HBI to identify patients who are at higher risk for different 
disease categories/events.  

Please refer to the HBI solutions Risk Model Overview section for more information on 
factors influencing the risk model.  



A potential use case for this module could be to help a healthcare organization identify 
which patients to proactively allocate more resources towards to avoid readmissions. 

 

Filters 

Filter: Date Range 
See General functionality > Filters> Date Range section. 

Filter: Attribution 

• Attribution (Note: In order for this filter to populate, the Focus360 customer 
must provide us with a payer attribution file) 

• Provider Attribution (only applicable for IPA/ACO customers): options 
based on attribution file 

• Health Plan Name: options based on attribution file 
• Line of Business: options based on attribution file 

Filter: Demographic 
See General Functionality > Filters> Demographics section. 

Filter: Dx and Disease 
See Population Risk Management > Filter > Filter: Dx and Disease section. 

Filter: Population Risk 
See Population Risk Management > Filter > Filter: Population Risk section. 

Filter:Transition Risk 
Allows filtering on the following risk classes for either IP 30 day readmission or ED 30 Day 
Revsit Risk: 

- Low 
- Medium 
- High 
- Very High 

Filter: Encounter 
Allows filtering on select encounters based on –  

- Primary Diagnosis Category  
- Primary Procedure Category 

https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering
https://healthix473.sharepoint.com/Team%20Innovation/Shared%20Documents/Focus360%20-%20External%20collaboration/InforMD%20work/User%20Guide.docx#_Filtering


Encounter Toggles 
 

Encounter Status  
The module can be filtered on Encounter Status – either Active or Discharged. 

 

Discharged indicates they are no longer active in that specific encounter (i.e. admission 
and discharge date available) and Active indicates a patient is currently in an inpatient or 
emergency bed, while Discharged 

Encounter Type  
The module can be filtered on Encounter Type – either Inpatient or Emergency. 

Inpatient (IP)  
When Active Inpatient Encounters are selected, the charts below expresses the risk class 
distribution for the 30-day readmission risk and the length of stay distribution measured in 
days. 

When Discharged Inpatient Encounters are selected, the chart represents the final risk 
class distribution at the time of discharge and the length of stay distribution measured in 
days. 

Chart View vs.Table View – Risk Class Distribution Discharged Inpatient Encounters 

 

Chart View vs. Table View – Length of Stay Distributin Discharged Inpatient Encounters  



  

 

Emergency (ED)  
When Active Emergency Encounters are selected, the chart below expresses the risk class 
distribution for the 30-day revisit risk and the length of stay distribution measured in hours.  

When Discharged Emergency Encounters are selected, the chart represents the final risk 
class distribution at the time of discharge and the length of stay distribution measured in 
hours. 

Chart View vs.Table View – Risk Class Distribution Discharged Emergency Encounters 

  

Chart View vs.Table View – Length of Stay Distribution Discharged Emergency Encounters 

  



Total Encounters 
Total Encounters in the top right corner will display of the total number of encounters in 
the last 60 days for your organization’s patients – based on the encounter status and type 
toggle selected. 

 

Please refer to Data dictionary for definitions of all Data Elements (Inpatient/Emergency, 
Length of Stay, Risk Class, etc.) 

 
 

 

Patient List 
The patient list includes a list of encounters based on the model selected (either IP30D or 
ED30D) and identifiers such as name, ID, date of birth and gender. The list includes an 
assigned risk score for the selected risk model (IP30D or ED30D) and the assigned risk 
score for the Mortality1Y risk model.  Lastly, the patient list includes the following 
encounter information: 

- Admission date 
- Discharge date (if applicable) 
- Admission source 
- Discharge disposition 
- Primary Diagnosis Code 
- Primary Diagnosis Description 
- Primary Procedure Code 
- Primary Procedure Description 

When filters are applied, the patient list will update to reflect the charactersitcs of the 
selected cohort. The list can be exported to Excel by selecting ‘Export’ in the top right 
corner.  

Please refer to Data dictionary for direct data element definitions. 

Quality Measures – Person View 
Description 
This module can be used to track quality measure outcomes for a set of quality measures 
that have been built into Focus360.  By default, when a user opens the module, they will 



see a report in which each row represents a patient that has been eligible for one of these 
quality measures.   The report shows whether the patient is compliant, or is not compliant, 
with each measure for which they have met the eligibility criteria.  The report can be sorted 
by Patient ID to show each patient’s compliance status for all relevant quality measures. 
The report can also be filtered by measure or sub-measure to show the compliance status 
for all patients who have met the eligibility criteria for that measure.  

The report shows whether a patient is compliant, the beginning and end of the eligibility 
period, and the facility where the patient received care that met the compliance criteria.  
Using this information, a Focus360 customer may decide to focus their care management 
resources on patients who are not compliant to close a gap in care.  Customers who are 
committed to quality measure goals in value-based contracts may also find evidence that 
gaps have been closed for patients that otherwise would have been reported as non-
compliant.  This can help customers increase their performance metrics and qualify for 
incentive funding.  

Quality Measures Included 
Focus360 currently includes both encounter based and person-based quality measures 
(and sub measures) that are of high priority for FQHCs, BHOs, CBOs, IPAs and ACOs. 
Please refer to the Data Dictionary for information on quality measure numerator and 
denominator inclusion and exclusion criteria. 

The measures and sub-measures currently in Focus360 are: 

Person-Based Measures 
- Breast Cancer Screening 
- Blood Pressure Control for Patients with Diabetes 
- Controlling High Blood Pressure 
- Cervical Cancer Screening 
- Eye Exam for Patients with Diabetes 
- Hemoglobin A1C Control for Patients with Diabetes 

o HbA1c <8 
o HbA1c >9 

- Kidney Health Evaluation for Patients with Diabetes 
- Well-Child Visits in the First 30 Months of Life 

o 0-15 months 
o 15-30 months 

- Child and Adolescent Well Care Visits 



Encounter-Based Measures 
- Follow-up After ED Visit for Substance 

o 30-day follow-up 
o 7-day follow-up 

- Follow-up After Hospitalization for Mental Illness 
o 30-day follow-up 
o 7-day follow-up 

- Prenatal and Postpartum Care 
o Prenatal Care 
o Postpartum Care 

- Patient Engagement after IP discharge 
o Patient Engagement after IP discharge 
o Medication Reconcilitation post-discharge 

Filters 
- Demographics: See General Functionality > Filters> Demographics section. 
- Attribution (Note: In order for this filter to populate, the Focus360 customer must 

provide us with a payer attribution file.): 
o Provider Attribution (only applicable for IPA/ACO customers): options based 

on attribution file 
o Health Plan Name: options based on attribution file 
o Line of Business: options based on attribution file 

- Measure - Allows Filtering on the following: 
o Measure Name  
o Sub-Measure Name 
o Last Compliant Location 

Columns 
The report includes the following columns. Please refer to Focus360 Data dictionary on the 
definition of these Elements. 

- Measure Name 
- Sub Measure Name 
- Compliant State 
- Trigger Date 
- Due Date 
- Last Compliant Date 
- Last Compliant Location 
- Measurement 
- First Name 
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- Last Name  
- Patient ID 
- Member Organization 

Quality Measures – Measure View 
Description 
The “Quality Measures: Measure View” provides access to similar data as the “Person 
View” module, but the data is presented in a format that focuses on organizational 
performance by measure rather than individual patient compliance.  The module helps 
Focus360 customers understand their current compliance rate by measure, comparative 
performance of sub-units within their organization, and which patients meet the eligibility 
criteria for a given measure.    

Quality Measures Included 
Refer to the Quality Measures – Person View > Quality Measures Included section for a full 
list of person and encounter-based measures and submeasures included. 

Filters 
- Demographic: See general functionality > Filters> Demographics section. 
- Dx and Disease: See Population Risk Management > Filter > Filter: Dx and Disease 

for description. 
- Attribution –(Note: In order for this filter to populate, the Focus360 customer must 

provide us with a payer attribution file) 
o Provider Attribution (only applicable for IPA/ACO customers): options based 

on attribution file 
o Health Plan Name: options based on attribution file 
o Line of Business: options based on attribution file 

Measure List 
At the top of the page, there is a report listing each measure and the current compliance 
rate for that measure.  The measures are divided into two groups, Person-based and 
Encounter-based, that a user can toggle between.  Each row shows the denominator of 
eligible patients, the numerator of compliant patients, and the calculated compliance rate.  
The compliance rates reflect performance as of 1 to 2 days prior, since Focus 360 data is 
typically updated within 24-48 hours of when it is recorded by a provider organization. 

Selecting a measure on the list (the line item will be highlighted in blue when selected), will 
update the Measure Comparison and Patient List charts to display data unique to the 
selected measure. 
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Measure Comparison 
The next section of the page is a chart showing the comparative performance of sub-units 
within the larger organization.  Focus360 users can review these comparative scores and 
help identify best practices at certain locations that can be shared with others to improve 
overall performance.  The chart reflects performance on the specific quality measure 
selected in the Measure List section. 

Patient List 
The last section of the page is a report that shows individual patient compliance status.   
When a specific performance measure is selected at the top of the page, this report 
updates to display the individual patients who have met the eligibility criteria for that 
measure.  This information closely matches the report in the “Quality Measures: Person 
View” module, but it is filtered to the specific quality measure selected in the Measure List 
section. The columns include –  

- Patient ID 
- First Name 
- Last Name 
- Date of Birth 
- Age 
- Gender 
- Compliant State (Y/N) 
- Trigger Date 
- Due Date 
- Last Compliant Date 
- Last Compliant Location 

 

Patient Profile 
Description 
The Patient Profile in Focus360 is a central source of demographic, predictive risk, and 
clinical information for a selected patient. It includes summary statistics on utilization and 
comprehensive lists of clinical history, encounters, procedures, labs, medication, and 
problems.  

The patient profile can be accessed by search or via clicking on the patients name within a 
module or report. Access to the patient profile is consent driven. The patient profile will 
only be accessible for patients who have granted consent. If there is no consent or a deny 
consent status on file for a patient, then a Patient Profile will not be provided for that 
patient in Focus360.  
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As described under the Patient List section, a bolded patient name indicates that consent 
has been obtained, thus if selected, will navigate to the Patient Profile. If the text is not 
bolded, this means that consent for that patient was not obtained and is not selectable.  

 

 

 

Tabs  

Future Risk 

 



 

This portion of the patient profile will provide details around the patient’s risk for each of 
the ten Risk Models (Refer to Population Risk Management > Risk Models for more 
information on each model).  

Risk Model Categories (Risk Model Name): 

o  Utilization (Future Cost, Inpatient Admission and Emergency Visit) 
o  Event (Mortality, Asthma Exacerbation, Suicide Attempt, Overdose) 
o  Condition (COPD, Diabetes, Opiod Abuse) 

Risk Class: 

o L = Low: definition – Relative risk < 1 
o M = Medium: definition - Relative risk between 1 - 3 
o H = High: definition - Relative risk between 3 - 5 
o VH = Very High: definition - Relative risk > 5 

 

See Data Dictionary for definition of Risk Score and HBI Solutions Resources explaining 
risk model education available in Data Dictionary. 

Selecting a risk model under the Future 12 Months Risks tab will update the Risk Trend 
Graph and the Risk Features table 

Risk Features  

The list of risk features includes the categories, description, and odds ratio . The Risk 
Features more information on why a patient is Low/Medium/High/Very High Risk for the 



selected risk model. See Population Risk Management > HBI Solutions Risk Model 
Overview for more information on risk features, and see Data dictionary for the definition of 
Risk Feature. 

Risk Categories- The options for Risk Categories are listed below in order. Within 
each category, Within each category, features are sorted high to low by odds ratio. 

 Demographics 
 Utilization 
 Acute disease/ disease event 
 Procedures 
 Factors influencing health status 
 Laboratory results 
 Medications 
 Community social determinants 

Risk Description -See Data dictionary for the definition of Risk Description 

Odds Ratio- See Data dictionary for the definition of Odds Ratio  

Diagnoses/ Clinical Summary 
Includes a comprehensive list of the patient’s chronic diseases in the past 24 months, 
acute disease conditions in the  past 12 months, COVID-19 Related history, and Lifestyle 
Diagnosis (including ICD10 codes that begin with the letter Z, broken down into 3 
categories: Social Determinants of Health, BMI & Lifestyle Factors, and Other Factors 
Influencing Health) 

Encounter History 
 A comprehensive list of all inpatient, outpatient, and emergency encounters for the 
patient in the last 24  months. Includes encounter type, facility, admission and discharge 
date, and diagnosis information.  

Procedure History:  
A comprehensive list of all procedures for the patient in the last 24 months. Includes 
admission date, encounter facility, procedure code and description. 

Lab Results 
A comprehensive list of lab history for the patient from up to 24 months prior. Includes test 
code, result description test coding system, result date, test location and result value. 
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Medications 
A list of medication history for the patient from up to 24 months prior. Includes drug code, 
drug description, drug coding system, and dispensed date/time. 

Note that this is not a complete history of medications, nor should it be considered a 
complete list of medications and should not be used as a sole source for a medication 
reconciliation activity 

Problem List 
A list of problems documented for the patient from up to 36 months prior. Includes 
problem code, problem description, problem facility, and date. 

Platform Support 

Customer Support 
If you encounter any issue with Focus360, you can open a helpdesk ticket with our 
Customer Support team by visiting https://cx.healthix.org/contact  

Please make sure you specify if the issue is application related or data related and include 
as much detail about the issue as possible. 

Troubleshooting & FAQ’s 
The sections below describes commonly asked questions and minor errors that may occur 
and how to resolve them. 

Identifying and solving problems 

Error Cause Solution 

Unable to login  This can be due to a variety 
of reasons. 

Please open a ticket with 
our Customer support team 
here. 

Login is blocked This can be due to a variety 
of reasons, such as your 
security settings. 

Please open a ticket with 
our Customer support team 
here. 

Data issue (missing, etc)  This can be due to a wide 
variety of reasons. 

Please contact our 
Customer Support team. 
Healthix will review this on 
a case by case basis to 
determine the cause. 

This is a table that outlines common errors that may occur, what typically causes them, and how to resolve it 

 

https://cx.healthix.org/contact
https://cx.healthix.org/contact
https://cx.healthix.org/contact


Frequently Asked Questions 
Who do I contact if I have questions about the product?  

If you have any questions with respect to how to use the product, support, 
troubleshooting, data analysis, or billing, please contact your Business Relationship 
Manager. If you don’t know your Business Relationship Manager, you can look them up 
here: https://cx.healthix.org/find-your-relationship-manager  

Is Healthix NCQA Certified?  

Yes, 80% of Healthix data is NCQA certified with Primary Source Verification! You can find 
our certification status here. 

https://reportcards.ncqa.org/other-health-care-organization/Other_0014100001nXShEAAW
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